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Osobenosti 
sistema DBMS 

1
Sistem za upravljanje bazom podataka vam 
je neophodan za izvršavanje SQL programa. 
Možete da imate svoju privatnu kopiju sistema 
DBMS koja se izvršava na lokalnom računaru 
ili možete da koristite deljeni DBMS preko 
mreže. U drugom slučaju, lokalni računar kori-
stite za povezivanje sa serverom sistema DBMS 
koji se izvršava na drugom računaru. Računar 
na kojem se izvršava DBMS naziva se server.

Pošto je ovo knjiga o SQL-u, a ne o sistemima 
DBMS, neću govoriti o instrukcijama za insta-
liranje i konfigurisanje softvera baze podataka.
Ovo izbegavanje možda na prvi pogled izgleda 
kao preletanje, ali podešavanje sistema DBMS 
veoma zavisi od snabdevača, proizvoda, ver-
zije, izdanja i operativnog sistema. Svi sistemi 
DBMS se dobijaju sa veoma obimnom doku-
mentacijom za instaliranje i administriranje, 
priručnicima i udžbenicima. (Da biste stekli 
predstavu o tome, samo priručnik za instalira-
nje Oracla ima preko 300 strana.)
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Izvršavanje SQL programa
U ovom poglavlju ću opisati kako se izvrša-
vaju SQL programi na sledećim sistemima 
DBMS:

◆ Microsoft Access 2003

◆ Microsoft SQL Server 2000

◆ Oracle 10g

◆ IBM DB2 8

◆ MySQL 5

◆ PostgreSQL 8

Ovo su najpopularniji komercijalni sistemi 
DBMS i sistemi DBMS otvorenog izvornog 
koda. SQL primere iz ove knjige sam testirao 
na navedenim izdanjima. Svi primeri rade 
na najnovijim verzijama, a pojedini rade i 
na starijim verzijama. Usklađenost sa SQL 
standardom obično se poboljšava u svakom 
narednom izdanju.

Grafički interfejs Microsoft Accessa dozvo-
ljava izvršavanje samo jednog SQL iskaza u je-
dnom trenutku. Drugi sistemi, svi DBMS ser-
veri, dozvoljavaju da izvršavate SQL programe 
u interaktivnom režimu ili u režimu skripta. 
U interaktivnom režimu, u komandni prozor 
unosite pojedinačne SQL iskaze, a rezultati 
svakog SQL iskaza prikazuju se posebno, 
tako da se ulaz i izlaz naizmenično smenjuju. 
U režimu skripta (takođe se naziva i grupni 
režim) ceo SQL program čuvate u okviru 
tekstualne datoteke (koja se naziva skript ili 
grupna datoteka), a alatka komandnog pro-
zora uzima datoteku, izvršava program i vraća 
rezultat bez potrebe da vi nešto tu uradite. 
U svim primerima ovog poglavlja korišćen je 
primerak baze podataka i SQL program koji 
su prikazani u listingu 1.1. Takođe je opisana 
i osnovna sintaksa alatki komandnog prozora; 
kompletna sintaksa je data u okviru doku-
mentacije sistema DBMS.

Listing 1.1 Ova datoteka, koja se naziva listing0101.
sql, sadrži jednostavan SQL iskaz SELECT, koji se 
koristi za zadavanje upita nad primerkom baze po-
dataka u narednim primerima za različite sisteme 
DBMS.

SELECT au_fname, au_lname

  FROM authors

  ORDER BY au_lname;

Listing

Komandna linija
Većina profesionalaca za rad sa bazama 
podataka radije zadaje komande i SQL 
skriptove preko okruženja komandnog 
prozora sistema DBMS nego preko menija 
i grafičkog interfejsa. (Administratori baza
podataka ne dodaju 1000 korisnika po-
moću miša.) Ako ste tek počeli da koristite 
sisteme DBMS, možda će vam komandna 
linija izgledati tajanstveno i zastrašujuće, 
ali ćete kasnije videti njenu snagu, jedno-
stavnost i brzinu. Grafičke alatke ipak
imaju nekoliko prednosti:

◆ punu podršku za isecanje, kopiranje i 
umetanje,

◆ neograničeno horizontalno i vertikalno 
pomeranje,

◆ mogućnost promene širine kolona 
prevlačenjem pomoću miša,

◆ bolju istoriju komandi i rezultata.

Ljubitelji komandne linije mogu pogledati 
HenPlus, (http://henplus.sourceforge.
net) besplatnu SQL ljusku sa svim funkcio-
nalnostima, koja radi na sistemima DBMS. 
Windows može da izvršava popularne 
Unix ljuske pomoću Cygwina (www.cygwin.
com) ili UWIN-a (www.research.att.com/
sw/tools/uwin).
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Imena putanja
Ime putanje određuje jedinstvenu lokaciju 
direktorijuma ili datoteke u hijerarhiji 
datotečkog sistema. Apsolutno ime putanje 
u potpunosti određuje lokaciju, počevši 
od najvišeg čvora u stablu direktorijuma, 
koji se naziva koren (engl. root). Relativno 
ime putanje određuje relativnu lokaciju u 
odnosu na tekući (ili radni) direktorijum. U 
Windowsu, apsolutna putanja počinje ko-
som crtom unazad (\) ili slovom koje ozna-
čava upravljačku jedinicu iza kojeg sledi 
dvotačka i kosa crta unazad. Kod Unixa ili 
Mac OS X Terminala, apsolutna putanja 
počinje običnom kosom crtom (/).

C:\Program Files\Microsoft SQL Server 

(Windows) i /usr/local/bin/mysql (Unix) 
predstavljaju primere apsolutnih putanja. 
scripts\listing0101.sql (Windows) i 
doc/readme.txt (Unix) su relativne putanje. 
Apsolutna imena putanja za datoteke i di-
rektorijume na mreži mogu počinjati dvo-
strukom kosom crtom unazad i imenom 
servera (na primer, \\someserver).

Ime putanje obično se skraćeno naziva pu-
tanja. Iako je razlika očigledna na osnovu 
konteksta, koristiću termin ime putanje 
kako bih izbegao zabune i mešanje sa 
promenljivom okruženja PATH.

✔ Saveti
■ Kada navodite ime SQL datoteke u režimu 

skripta, možete da stavite apsolutno ili 
relativno ime putanje (videti kolonu pored 
u ovom odeljku).

■ Da biste pokrenuli alatku komandnog 
prozora iz bilo kog konkretnog direktori-
juma, putanja mora da sadrži direktori-
jum koji u stvari sadrži tu alatku. Putanja 
predstavlja spisak direktorijuma koje ope-
rativni sistem pretražuje kako bi pronašao 
programe. Kod nekih sistema DBMS, 
program za instaliranje rukuje detaljima 
o putanjama; kod drugih, morate sami da 
ubacujete u putanju direktorijum alatke.

Da biste videli putanju na kojoj se nala-
zite, unesite u komandni prozor path 
(Windows) ili echo $PATH (Unix ili Mac 
OS X Terminal). Da biste promenili puta-
nju, promenljivoj okruženja path dodajte 
direktorijum u kojem se alatka nalazi ili 
izmenite komandu path u inicijalizacio-
noj datoteci, koja se obično naziva .bash_
login, .bashrc, .cshrc, .login, .profile ili 
.shrc (Unix ili Mac OS X).

■  DBMS FileMaker Pro (www. 
   filemaker.com) je popularni stoni 
program baze podataka koji podržava 
podskup SQL-a. Za izvršavanje SQL 
iskaza možete da koristite alatku SQL 
Query Builder ili postupak Execute SQL 
script.

Sybase Adaptive Server (www.sybase.
com) predstavlja popularni server siste-
ma DBMS. Sybase i Microsoft su nekad 
imali dogovor o deljenju izvornog koda 
i njihovi sistemi DBMS su bili skoro 
identični. Pre nekoliko godina, svaka 
od tih kompanija je razvila sopstveni 
proizvod. Međutim, zajedničko nasleđe 
znači da većina SQL primera koja radi na 
Microsoft SQL Serveru, radi i na Sybase 
Adaptive Serveru.
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Microsoft Access
Microsoft Access predstavlja komercijalni 
stoni sistem DBMS. Access je pogodan za 
upravljanje bazama podataka koje su male ili 
srednje veličine. O Accessu možete naučiti 
nešto više i dobiti probnu kopiju na period od 
30 dana na lokaciji www.microsoft.com/office/
access.

Ova knjiga pokriva Microsoft Access 2003, 
ali takođe sadrži savete za prethodne verzije. 
Da biste odredili koju verziju Accessa imate, 
u meniju izaberite Help> About Microsoft 
Access.

U Accessu morate da za bazu podataka 
uključite režim SQL upita ANSI-92 kako biste 
mogli da izvršavate SQL upite koji koriste 
ANSI-92 SQL sintaksu (to jest, većinu primera 
iz ove knjige).

Da biste za bazu podataka uključili 
režim SQL upita ANSI-92:
1. U Accessu otvorite bazu podataka ako je 

neophodno.

2. Izaberite jezičak Tools>Options>Tables/
Queries.

3. U odeljku SQL Server Compatible Syntax 
(ANSI 92) označite polje za potvrdu This 
Database (slika 1.1).

4. Pritisnite OK.

Access će zatvoriti, sažeti i ponovo otvoriti 
bazu podataka kako bi nova podešavanja 
imala efekta.

✔ Saveti
■ Uopšteno, vodite računa o prelasku iz 

ANSI-89 u ANSI-92 režim upita i obratno. 
Ta dva režima nisu kompatibilna, pa bi 
bilo idealno da izaberete režim prilikom 
pravljenja baze podataka i da ga posle ni-
kada ne menjate. Tipovi podataka, rezer-
visane reči i džoker znakovi razlikuju se u 
zavisnosti od režima, tako da SQL iskazi 
koji su napravljeni u jednom režimu, mo-
žda neće raditi u drugom režimu.

Slika 1.1 Označite ovo polje kako biste uključili režim 
SQL upita ANSI-92 kod baze podataka koja je otvo-
rena.

■ Ako želite više informacija o režimima 
upita, u Access Helpu potražite temu ansi 
sql query mode. 

■  ANSI-92 režim je kompatibilan  
     sa Microsoft SQL Serverom. 
Ako imate Access 97 ili neku od pretho-
dnih verzija, morate da koristite ANSI-89 
režim.
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Slika 1.2 Na paleti alatki, pritisnite du-
gme New kako biste napravili novi upit.

Slika 1.3 Izaberite Design View kako biste izbegli 
čarobnjake.

Slika 1.4 Ne treba grafički da dodajete tabele zato
što sam SQL iskaz specificira tabele.

Slika 1.5 SQL View 
sakriva grafičku mrežu
upita i prikazuje editor 
teksta u koji možete da 
unesete ili kopirate SQL 
iskaz.

Ako ste povremeni korisnik Accessa, vero-
vatno ste koristili Design View za pravljenje 
upita. Kada upit pravite u prikazu Design 
View, Access u pozadini pravi ekvivalentan 
SQL iskaz. U prikazu SQL View možete da 
prikažete, menjate i izvršavate taj upit.

Da biste izvršili SQL upit:
1. Otvorite bazu podataka ili pritisnite F11 

da biste prešli na prozor Database u bazi 
podataka koja je već otvorena.

2. U prozoru Database, pritisnite na Queries 
(ispod Objects); zatim u paleti alatki priti-
snite New (slika 1.2).

3. U okviru za dijalog New Query, pritisnite 
Design View; zatim pritisnite OK (slika 
1.3).

4. Nemojte da dodajete tabele ili upite, već 
u okviru za dijalog Show Table pritisnite 
Close (slika 1.4).

5. Izaberite View>SQL View (slika 1.5).

nastavak na sledećoj strani
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6. Unesite ili kopirajte SQL upit (slika 1.6).

7. Da biste izvršili SQL iskaz, u paleti alatki 
pritisnite ikonu !, ili izaberite Query > Run 
(slika 1.7).

Access prikazuje rezultate iskaza SELECT 
(slika 1.8), ali ostale tipove iskaza izvršava u 
tišini ili prikazuje poruke upozorenja, u zavi-
snosti od podešavanja.

✔ Savet
■ Preko objekta Query možete da izvršite 

samo jedan SQL iskaz. Kako biste izvršili 
više iskaza, možete da koristite više obje-
kata Query ili host jezik kao što je Visual 
Basic ili C #.

Slika 1.6 Unesite SQL iskaz...

Slika 1.7 ...i izvršite ga.

Slika 1.8 Access prikazuje rezultat iskaza SELECT.
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Microsoft SQL Server
Microsoft SQL Server je komercijalni sistem 
DBMS koji podržava veoma velike baze po-
dataka i veliki broj transakcija. Izvršava se 
samo na operativnim sistemima Microsoft 
Windows i toliko je složen da zahteva stalnog 
administratora baze podataka za održavanje i 
izvršavanje sistema. Sa lokacije  
www.microsoft.com/sql/evaluation možete 
preuzeti besplatnu verziju na 120 dana.

Ova knjiga pokriva samo Microsoft SQL 
Server 2000. Da biste odredili koju verziju 
Microsoft SQL Servera imate, u komandnom 
prozoru SQL Servera izvršite komandu osql 
–E –Q "SELECT @@VERSION;" (ili izvršite upit 
SELECT SERVERPROPERTY('ProductVersion');). 
Pogledajte tekst koji sledi ako imate SQL 
Server 2005 ili SQL Server Express.

SQL Server 2005
SQL Server 2005, naslednik SQL Servera 2000, ima kompatibilnost unazad sa verzijom 2000 
što se tiče oblasti koju pokriva ova knjiga, tako da će svi primeri koje budete našli u ovoj knjizi 
raditi i na SQL Serveru 2005. Evo šta treba da znate u vezi sa izvršavanjem SQL programa na 
SQL Serveru 2005:

◆ Alatku Query Analyzer zamenjuje nova alatka koja se naziva SQL Server Management 
Studio Query Editor.

◆ Nova alatka komandnog prozora, koja se naziva sqlcmd, zamenjuje alatku osql. sqlmd 
ima veliki broj istih opcija komandne linije kao osql. Izvršite komandu sqlcmd -? da biste 
videli pregled sintakse.

◆ SQL Server 2005 Express Edition (SQL Server Express) je besplatna, laka za korišćenje, 
lagana verzija SQL Servera 2005. Možete je preuzeti sa lokacije www.microsoft.com/sql. 
Dobija se sa grafičkom alatkom za upravljanje, Express Manager.
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Za izvršavanje SQL programa možete da 
koristite grafičku alatku SQL Query Analyzer
ili alatku komandnog prozora osql.

Da biste koristili alatku SQL Query 
Analyzer:
1. Na radnoj površini Windowsa, izaberite 

Start > All Programs > Microsoft SQL 
Server > Query Analyzer.

2. U okviru za dijalog Connect to SQL Server 
izaberite server i način provere autenti-
čnosti; zatim pritisnite OK.

3. U paleti alatki (blizu gornje ivice prozora) 
iz padajuće liste izaberite bazu podataka 
(slika 1.9).

4. Da biste interaktivno izvršavali SQL 
iskaze, unesite ili kopirajte SQL iskaz u 
prozor upita

ili 

Da biste izvršili SQL skript, izaberite File 
>Open (ili pritisnite Ctrl+Shift+P); kreći-
te se do datoteke sa skriptom i označite 
je, a zatim pritisnite Open.

5. Izaberite Query >Execute (ili pritisnite 
F5). SQL Query Analyzer prikazuje rezul-
tate u donjem oknu (slika 1.10b).

✔ Savet
■ SQL Query Analyzer možete pokrenuti i 

izvršavanjem komande isqlw u koman-
dnom prozoru.

Da biste interaktivno koristili alatku 
komandnog prozora osql:
1. Unesite u komandni prozor sledeću ko-

mandu:

osql –E –d dbname

Opcija –E govori SQL Serveru da treba da 
koristi vezu od poverenja umesto da traži 
lozinku. dbname predstavlja ime baze 
podataka koja treba da se koristi.

2. Unesite SQL iskaz. Iskaz može da se 
proširi na nekoliko redova. Iskaz završite 
tačka zarezom (;), a zatim pritisnite Enter.

3. Unesite go i pritisnite Enter kako biste 
prikazali rezultate (slika 1.11).

Slika 1.9 SQL Query 
Analyzer koristi iza-
branu bazu podataka 
za razrešavanje refe-
renci unutar vaših SQL 
iskaza.

Slika 1.10 Rezultati iskaza SELECT u okviru alatke 
SQL Query Analyzer

Slika 1.11 Isti SELECT iskaz u interaktivnom režimu 
alatke osql
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Slika 1.12 Isti SELECT iskaz u režimu skripta alatke 
osql

Da biste koristili alatku komandnog 
prozora osql u režimu skripta:
1. Unesite u komandni prozor sledeću ko-

mandu:

osql –E –d dbname –n –i sql_script

Opcija –E govori SQL Serveru da treba da 
koristi vezu od poverenja umesto da traži 
lozinku. dbname predstavlja ime baze 
podataka koja treba da se koristi. Opcija 
–n ukida brojeve i odzivne simbole (>) u 
izlaznom rezultatu. sql_script predsta-
vlja tekstualnu datoteku koja sadrži SQL 
iskaz (e) i može da sadrži apsolutno ili 
relativno ime putanje.

2. Pritisnite Enter da biste prikazali rezul-
tate (slika 1.12). 

Da biste izašli iz alatke komandnog 
prozora osql:
◆ Unesite exit ili quit, a zatim pritisnite 

Enter.

Da biste prikazali opcije alatke 
komandnog prozora osql:
◆ U komandni prozor unesite osql -?, a 

zatim pritisnite Enter.

✔ Saveti
■ Da bi se SQL Server što je moguće više 

usaglasio sa SQL standardom, možete da 
koristite opciju SET ANSI_DEFAULTS ON.

■ Ako SQL Server zahteva da unesete ko-
risničko ime i lozinku, umesto da koristi 
vezu od poverenja, zamenite opciju –E 
opcijom –U login_id. login_id je vaše 
korisničko ime. osql će tražiti da unesete 
lozinku.

■ Ako osql izvršavate sa udaljenog mrežnog 
računara, ubacite opciju –S server kako 
biste naveli instancu SQL Servera sa ko-
jom se povezujete. Uzmite od administra-
tora baze podataka parametre veze.
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Oracle
Oracle Database je vodeći komercijalni sistem 
DBMS. Podržava veoma velike baze podataka 
i veliki broj transakcija. Može da se izvršava 
na velikom broju različitih operativnih si-
stema i hardverskih platformi, a toliko je slo-
žen da zahteva stalnog administratora baze 
podataka za održavanje i izvršavanje sistema. 

O Oracle proizvodima možete naučiti nešto 
više na lokaciji www.oracle.com. Pritisnite vezu 
Download i pogledajte kategoriju Databases. 
Nakon što se registrujete i prihvatite uslove 
licence, moći ćete da preuzmete besplatnu 
verziju sistema Oracle Database, s jednim 
prototipom i samo za razvoj. Dokumentacija 
se nalazi na lokaciji www.oracle.com/ 
technology/documentation. 

Ova knjiga pokriva Oracle 10g, ali takođe 
sadrži savete za prethodne verzije. Verzija 
Oracla koju vi imate je prikazana u inicijalnoj 
poruci „Connected to” koja se pojavljuje kada 
se prijavljujete na SQL*Plus ili sqlplus (ili 
izvršite upit SELECT banner FROM v$version).

Za izvršavanje SQL programa možete da 
koristite grafičku alatku SQL *Plus ili alatku
komandne linije sqlplus.

Da biste koristili SQL *Plus:
1. Pokrenite SQL * Plus. 

Ova procedura se razlikuje u zavisnosti 
od platforme. U Windowsu, na primer, 
izaberite Start >All Programs> Oracle 
– OraDb10g_home1 > Application 
Development > SQL Plus.

2. Unesite svoje korisničko ime, lozinku i 
ime baze podataka, a zatim pritisnite OK 
(slika 1.13). 

Ako se povezujete sa udaljenom bazom 
podataka, uzmite od administratora baze 
podataka parametre veze.

Slika 1.13 Ekran za prijavljivanje alatke SQL * Plus
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Slika 1.14 Rezultat interaktivnog iskaza SELECT kod 
alatke SQL * Plus

3. Da biste interaktivno izvršavali SQL 
iskaze, unesite ili kopirajte SQL iskaz. 
Iskaz može da se proširi na nekoliko re-
dova. Iskaz završite tačka zarezom (;), a 
zatim pritisnite Enter kako biste prikazali 
rezultate (slika 1.14).

ili

Da biste izvršili SQL skript, unesite 
@sql_script, a zatim pritisnite Enter 
kako biste prikazali rezultate (slika 
1.15). sql_script je tekstualna datoteka 
koja sadrži SQL iskaz(e) i može da sadrži 
apsolutno ili relativno ime putanje.

O
racle

Slika 1.15 Isti iskaz SELECT koji se izvršava kao skript 
pomoću alatke SQL * Plus.
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Da biste interaktivno koristili alatku 
komandnog prozora sqlplus:
1. Unesite u komandni prozor sledeću ko-

mandu:

sqlplus user@dbname

user predstavlja vaše korisničko ime, a 
dbname predstavlja ime baze podataka 
koja treba da se koristi. sqlplus će od vas 
tražiti da unesete lozinku.

2. Unesite SQL iskaz. On može da se proširi 
na nekoliko redova. Iskaz završite tačka 
zarezom (;), a zatim pritisnite Enter kako 
biste prikazali rezultate (slika 1.16).

Da biste koristili alatku komandnog 
prozora sqlplus u režimu skripta:
◆ Unesite u komandni prozor sledeću ko-

mandu:

sqlplus user@dbname @sql_script

user predstavlja vaše korisničko ime, 
dbname predstavlja ime baze podataka 
koja treba da se koristi, a sql_script pred-
stavlja tekstualnu datoteku koja sadrži 
SQL iskaz (e) i može da sadrži apsolutno 
ili relativno ime putanje. Sqlplus će tra-
žiti da unesete lozinku i nakon toga će 
prikazati rezultate (slika 1.17). 

✔ Savet
■ Možete (ali ne bi trebalo) da navedete 

korisnika/lozinku umesto korisnika kako 
biste izbegli da se svaki put od vas traži da 
unesete lozinku.

Da biste izašli iz alatke komandnog 
prozora sqlplus:
◆ Unesite exit ili quit, a zatim pritisnite 

Enter.

Da biste prikazali opcije alatke 
komandnog prozora sqlplus:
◆ U komandni prozor unesite osqlplus -H, a 

zatim pritisnite Enter.

Slika 1.16 Rezultati iskaza SELECT u interaktivnom 
režimu alatke sqlplus

Slika 1.17 Isti iskaz SELECT u režimu skripta alatke 
sqlplus
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IBM DB2
IBM DB2 Universal Database je vodeći komer-
cijalni sistem DBMS. Podržava veoma velike 
baze podataka i veliki broj transakcija. Može da 
se izvršava na velikom broju različitih operati-
vnih sistema i hardverskih platformi, a toliko je 
složen da zahteva stalnog administratora baze 
podataka za održavanje i izvršavanje sistema. 

O DB2 proizvodima možete naučiti nešto više 
na lokaciji www.ibm.com/db2. Pritisnite vezu 
Trials and Betas kako biste preuzeli besplatno 
probno izdanje. Na raspolaganju imate ne-
koliko izdanja DB2 sistema; izdanje Personal 
Edition je verzija koja je besplatna i name-
njena jednom korisniku.

Ova knjiga pokriva verziju DB2 8. Da biste 
odredili koju verziju DB2 imate, izvršite u 
komandnom prozoru DB2 sistema komandu 
db2level.

Za izvršavanje SQL programa možete da 
koristite grafičku alatku Command Center
ili procesor komandne linije (command-line 
processor, CLP) koji se naziva db2.

Da biste koristili Command Center:
1. Pokrenite alatku Command Center. 

Ova procedura se razlikuje u zavisnosti 
od platforme. U Windowsu, na primer, 
izaberite Start >All Programs> IBM DB2 
> Command Line Tools > Command 
Center. U Unixu to možete uraditi pomo-
ću komande db2cctr. 

Ako je alatka Command Center otvore-
na, izaberite Tools > Command Center ili 
pritisnite .

2. Za tip komande izaberite SQL Statements 
and DB2 CLP Commands.

3. Ako je potrebno, pređite na karticu Inte-
ractive.

4. U polju Database Connection, pritisnite 
na druga ikona na strani 13; proširite 
stablo objekta dok ne dođete do direktori-
juma Databases; izaberite bazu podataka, 
a zatim pritisnite OK.

nastavak na sledećoj strani
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5. Da biste interaktivno izvršavali SQL 
iskaze, unesite ili kopirajte SQL iskaz u 
polje Command (slika 1.18). 

ili

Da biste izvršili SQL skript, pređite na 
karticu Scripts, izaberite Script > Import; 
krećite se dok ne pronađete i izaberete 
datoteku skripta, a zatim pritisnite OK.

6. Pritisnite na  ili pritisnite Ctrl+Enter.

ili

Izaberite Interactive > Execute or Script 
> Execute.

Rezultati interaktivnog SQL-a se pri-
kazuju na kartici Results (slika 1.19). 
Rezultati SQL skripta se prikazuju u 
polju ispod polja Script.

Iz tehničkih razloga koji se odnose na relacije 
između procesa, (samo) korisnici koji rade 
na operativnom sistemu Microsoft Windows 
moraju da pokreću procesor komandne linije 
db2 sa dodatnim prvim korakom.

Da biste pokrenuli procesor 
komandne linije db2 u Windowsu:
◆ Unesite u komandni prozor db2cmd i priti-

snite Enter.

ili

Izaberite Start >All Programs> IBM DB2 
> Command Line Tools > Command 
Window.

Pojaviće se novi komandni prozor DB2 
CLP.

✔ Saveti
■ Za sve komande procesora db2 (opisane 

kasnije) morate da koristite prozor DB2 
CLP. Ako pokušate da izvršavate db2 u 
standardnom Windowsovom koman-
dnom prozoru, DB2 će javiti grešku „Com-
mand line environment not initialized”.

■ Ako je potrebno, u prozoru DB2 CLP pro-
menite radni direktorijum (komandom 
cd) pre nego što počnete da izvršavate 
komande procesora db2.

Slika 1.18 Iskaz SELECT spreman za izvršavanje u 
okviru alatke Command Center

Slika 1.19 Rezultati iskaza SELECT 
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Slika 1.20 Isti iskaz SELECT u interaktivnom režimu 
procesora db2

Da biste interaktivno koristili 
procesor komandne linije db2:
1. Unesite u komandni prozor sledeću ko-

mandu:

db2 -t

a zatim pritisnite Enter. Opcija –t govori 
procesoru db2 da se iskazi završavaju 
tačka zarezom (;).

Pojavljuje se odzivnik procesora db2, =>.
2. Unesite u prozor db2 sledeću komandu:

Connect to dbname;

a zatim pritisnite Enter. dbname je ime 
baze podataka koja treba da se koristi. 

3. Unesite SQL iskaz. On može da se proširi 
na nekoliko redova. Iskaz završite tačka 
zarezom (;), a zatim pritisnite Enter kako 
biste prikazali rezultate (slika 1.20).

✔ Savet
■ Možete da izbegnete odzivnik procesora 

db2, => tako što ćete komande i SQL 
iskaze unositi direktno u komandnu li-
niju.

Na primer:

db2 connect to books
db2 SELECT * FROM authors

Ako izostavite opciju –t, kao što je ovde 
slučaj, ne završavajte iskaze i komande 
tačka zarezom.
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Da biste koristili procesor komandne 
linije db2 u režimu skripta:
1. Unesite u komandni prozor sledeću ko-

mandu:

db2 connect to dbname

dbname je ime baze podataka koja treba 
da se koristi.

2. Unesite u komandni prozor sledeću ko-
mandu:

db2 –t –f sql_script

sql_script predstavlja tekstualnu dato-
teku koja sadrži SQL iskaz (e) i može da 
sadrži apsolutno ili relativno ime puta-
nje. Opcija –t govori procesoru db2 da se 
iskazi završavaju tačka zarezom (;).

3. Pritisnite Enter kako biste prikazali rezul-
tate (slika 1.21). 

✔ Saveti
■ U koraku 2, možete da koristite opciju –v 

ako želite da kao izlaz dobijete sadržinu 
datoteke sql_script.

■ Dve alternativne alatke za izvršavanje 
skriptova su db2sql92 i db2batch.

Da biste izašli iz alatke komandnog 
prozora db2:
◆ U prozor db2 unesite quit, a zatim priti-

snite Enter. (Izostavite tačka zarez ako 
niste koristili opciju –t pri pokretanju 
procesora db2.)

Da biste prikazali opcije alatke 
komandnog prozora db2:
◆ U komandni prozor unesite db2 ?, a zatim 

pritisnite Enter.

Ova komanda prikazuje brzo nekoliko 
strana. Da biste videli stranu po stranu, 
unesite db2 ? | more, a zatim pritisnite 
Enter. Pritisnite taster razmaknicu za 
prelazak na narednu stranu.

Slika 1.21 Isti iskaz SELECT u režimu skripta proce-
sora db2

✔ Saveti
■ Ako želite pomoć kada se nalazite u 

odzivniku procesora db2, =>, unesite ? i 
pritisnite Enter. (Izostavite tačka zarez 
ako niste koristili opciju –t pri pokretanju 
procesora db2.)

■ DB2 za Linux, Unix i Windows (LUW) se 
razlikuje malo od DB2 koji je namenjen 
za druge platforme. U ovom odeljku se 
govori o LUW DB2. Ako imate neku drugu 
platformu (z/OS ili OS/390, na primer) 
komande će se možda razlikovati.
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Slika 1.22 Rezultati iskaza SELECT u interaktivnom 
režimu alatke mysql

Slika 1.23 Isti iskaz SELECT u režimu skripta alatke 
mysql

MySQL
MySQL je vodeći sistem DBMS otvorenog 
izvornog koda. Brz je, stabilan i podržava 
velike baze podataka i veliki broj transakcija. 
MySQL je poznat po svojoj brzini i lakoći kori-
šćenja. MySQL je besplatan za ličnu upotrebu 
i radi na velikom broju operativnih sistema i 
hardverskih platformi. Možete ga preuzeti sa 
lokacije www.mysql.com.

Ova knjiga pokriva samo MySQL 5, ali sadrži 
savete i za prethodne verzije. Da biste odredili 
koju verziju MySQL-a imate, u komandnom 
prozoru MySQL-a izvršite komandu mysql 
– V (ili izvršite upit SELECT VERSION();).

Za izvršavanje SQL programa možete da 
koristite alatku komandnog prozora koja se 
naziva mysql.

Da biste interaktivno koristili alatku 
komandnog prozora mysql:
1. Unesite u komandni prozor sledeću ko-

mandu:

mysql dbname

dbname predstavlja ime baze podataka 
koja treba da se koristi.

2. Unesite SQL iskaz. On može da se proširi 
na nekoliko redova. Iskaz završite tačka 
zarezom (;), a zatim pritisnite Enter kako 
biste prikazali rezultate (slika 1.22).

Da biste koristili alatku komandnog 
prozora mysql u režimu skripta:
1. Unesite u komandni prozor sledeću ko-

mandu:

mysql -t dbname < sql_script

Opcija –t formatira rezultate u vidu tabe-
le; ako želite da rezultat bude razdvojen 
tabulatorima, izostavite ovu opciju. 
dbname predstavlja ime baze podataka 
koja treba da se koristi. Znak < označava 
operator redirekcije koji čita datoteku 
sql_script. sql_script predstavlja tekstu-
alnu datoteku koja sadrži SQL iskaz (e) 

M
yS

Q
L



18

Poglavlje 1

i može da sadrži apsolutno ili relativno 
ime putanje.

2. Pritisnite Enter da biste prikazali rezul-
tate (slika 1.23). 

Da biste izašli iz alatke komandnog 
prozora mysql:
◆ Unesite quit ili \q, a zatim pritisnite Enter.

Da biste prikazali opcije alatke 
komandnog prozora mysql:
■ U komandni prozor unesite mysql -?, a 

zatim pritisnite Enter.

Ova komanda prikazuje brzo nekoliko 
strana. Da biste videli stranu po stranu, 
unesite mysql ? | more, a zatim pritisnite 
Enter. Pritisnite taster razmaknicu za 
prelazak na narednu stranu (slika 1.24).

✔ Saveti
■ Ako izvršavate MySQL sa udaljenog mre-

žnog računara, navedite server, korisničko 
ime i lozinku kako biste se povezali sa 
serverom pomoću sledeće komande

mysql –h host –u user –p dbname

host je ime servera, user je vaše korisni-
čko ime, a dbname je ime baze podataka 
koja treba da se koristi. mysql će tražiti da 
unesete lozinku. Uzmite od administra-
tora baze podataka parametre veze.

■ Da bi se MySQL što je moguće više usagla-
sio sa SQL standardom, možete da kori-
stite opciju ansi.

■ Ako vam se ne dopada komandni prozor, 
probajte da koristite grafičku alatku na-
menjenu velikom broju platformi, a koja 
se naziva MySQL Control Centre (My-
SQLCC). Možete je besplatno preuzeti sa 
lokacije www.mysql.com/products/mysqlcc.

■ Više informacija o softveru otvorenog 
izvornog koda možete naći na lokaciji 
www.opensource.org.

Slika 1.24 Ekran koji prikazuje pomoć kod alatke 

mysql.
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Slika 1.25 Rezultati iskaza SELECT u interaktivnom 
režimu alatke psql

Slika 1.26 Isti iskaz SELECT u režimu skripta alatke 
psql

PostgreSQL
PostgreSQL je vodeći sistem DBMS otvorenog 
izvornog koda. Brz je, stabilan i podržava 
velike baze podataka i veliki broj transakcija. 
PostgreSQL je poznat po bogatom skupu 
funkcionalnosti i velikoj usklađenosti sa stan-
dardnim SQL-om. PostgreSQL je besplatan i 
radi na velikom broju operativnih sistema i 
hardverskih platformi. Možete ga preuzeti sa 
lokacije www.postgresql.org.

Ova knjiga pokriva PostgreSQL 8, ali sa-
drži savete i za prethodne verzije. Da biste 
odredili koju verziju PostgreSQL-a imate, u 
komandnom prozoru PostgreSQL-a izvršite 
komandu psql – V (ili izvršite upit SELECT 
VERSION();).

Za izvršavanje SQL programa možete da 
koristite alatku komandnog prozora koja se 
naziva psql.

Da biste interaktivno koristili alatku 
komandnog prozora psql:
1. Unesite u komandni prozor sledeću ko-

mandu:

psql dbname

dbname predstavlja ime baze podataka 
koja treba da se koristi. Možda će se 
zahtevati da unesete lozinku.

2. Unesite SQL iskaz. On može da se proširi 
na nekoliko redova. Iskaz završite tačka 
zarezom (;), a zatim pritisnite Enter kako 
biste prikazali rezultate (slika 1.25).

Da biste koristili alatku komandnog 
prozora psql u režimu skripta:
1. Unesite u komandni prozor sledeću ko-

mandu:

psql -f sql_script dbname

sql_script predstavlja tekstualnu dato-
teku koja sadrži SQL iskaz (e) i može da 
sadrži apsolutno ili relativno ime puta-
nje, a dbname predstavlja ime baze poda-
taka koja treba da se koristi. 
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2. Pritisnite Enter da biste prikazali rezul-
tate (slika 1.26). 

Možda će se zahtevati da unesete lozin-
ku.

Da biste izašli iz alatke komandnog 
prozora psql:
◆ Unesite \q, a zatim pritisnite Enter.

Da biste prikazali opcije alatke 
komandnog prozora psql:
◆ U komandni prozor unesite psql -?, a 

zatim pritisnite Enter.

Ova komanda prikazuje brzo nekoliko 
strana. Da biste videli stranu po stranu, 
unesite psql ? | more, a zatim pritisnite 
Enter. Pritisnite taster razmaknicu za 
prelazak na narednu stranu (slika 1.27).

✔ Saveti
■ Ako izvršavate PostgreSQL sa udaljenog 

mrežnog računara, navedite server, kori-
sničko ime i lozinku kako biste se povezali 
sa serverom pomoću sledeće komande:

psql –h host –u user –W dbname

host je ime servera, user je korisničko 
ime, a dbname je ime baze podataka koja 
treba da se koristi. psql će tražiti da une-
sete lozinku. Uzmite od administratora 
baze podataka parametre veze.

■ Ako vam se ne dopada komandni prozor, 
probajte da koristite grafičku alatku na-
menjenu velikom broju platformi, a koja 
se naziva pgAdmin III. Možete je bespla-
tno preuzeti sa lokacije http://pgadmin.
org.

■ Više informacija o softveru otvorenog 
izvornog koda možete naći na lokaciji 
www.opensource.org.

Slika 1.27 Ekran koji prikazuje pomoć kod alatke 
psql.
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